
PLEASE READ BEFORE INSTALLATION

FROM PAST EXPERIENCE OF SUPPLYING SENSITIVE INSTRUMENTATION INTO THE 
LABORATORIES OF LUBRICANT COMPANIES, WE HAVE FOUND THAT TEST EQUIPMENT 
SUCH AS DRYING OVENS, STIRRERS, EQUIPMENT WITH LARGE ELECTRICAL MOTORS, 
OR OTHER APPLIANCES WHICH USE THYRISTOR OR UNSUPRESSED RELAYS TO 
CONTROL THEIR MAINS , CAN CAUSE TRANSIENT VOLTAGE SPIKES WHICH CAN 
ADVERSELY AFFECT OR IN EXTREME CASES DAMAGE COMPUTER EQUIPMENT.

ALTHOUGH BKT INSTRUMENTS ARE ADEQUATELY PROTECTED AND ARE ROBUST 
ENOUGH FOR THESE ENVIRONMENTS , MAINS SPIKES WHICH WILL PASS THROUGH 
COMPUTER POWER SUPPLIES CAN IRREPARABLY DAMAGE THE PC30AT COMPUTER 
CARD SUPPLIED WITH THIS EQUIPMENT.

THEREFORE WE STRONGLY RECOMMEND THE USE OF IN LINE MAINS SUPPRESSION 
FILTERS ON COMPUTER EQUIPMENT PLAYING HOST TO OUR DATA ACQUISITION 
CARDS.

FAILURE TO FIT SUCH MAINS PROTECT WILL INVALIDATE ANY WARRANTY OFFERED 
WITH THE SUPPLY OF THIS SPECIFIC COMPONENT.
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DESCRIPTIONS  AND INFORMATION

All drawings, specifications and particulars of weight and dimensions submitted with BKT's quotations 
are approximate only and the descriptions and illustrations contained in BKT's catalogues, brochures, 
price lists and other advertising matter are intended merely to present a general idea of the goods and / 
or services being provided and none  shall form part of any contract with BKT. Furthermore , BKT 
shall not be liable for the accuracy of any goods and/or services provided, nor for the interpretation of 
the data acquired or produced by such goods and /or services. Any performance figures given by BKT 
are based on its experience and are such as BKT would expect to obtain on test at its works. Such 
figures and data are not guaranteed.

BKT's LIMITED HARDWARE WARRANTY

BKT warrants to the Purchaser that the company's hardware is free from defects in workmanship or 
material under normal use and service. This warranty commences on the date of delivery of the 
hardware to the Purchaser.

During the warranty period , BKT agrees to repair or replace, at its sole discretion, without charge to 
the Purchaser, any defective component part of the hardware. To obtain service, Purchaser must return 
the hardware to BKT or an authorised agent of BKT in an adequate container for shipping. The 
postage, shipping and insurance charges incurred in shipping to BKT will be paid by Purchaser and all 
risk for the hardware shall remain with the Purchaser until such time as BKT takes receipt of the 
hardware. Upon receipt BKT will promptly repair or replace the defective unit, and then return the said 
unit to Purchaser, postage, shipping and insurance prepaid. In any event BKT's liability for defective 
hardware is limited to repairing or replacing the hardware.

EXCLUSIONS

This warranty is contingent upon proper use of the hardware by Purchaser and does not cover : 
expendable component parts such as PCI electrodes, PCI Mini-Cells, and DIGI-GALV test probes; or 
if damage is due to accident, unusual physical, electrical or electromechanical stress, neglect, misuse, 
failure of electrical power, air conditioning, humidity control, transportation, operation with media not 
approved by BKT , or by tampering with or altering of the hardware.

DURATION

THE WARRANTIES GIVEN HEREIN, TOGETHER WITH ANY IMPLIED WARRANTIES 
COVERING THE HARDWARE , ARE LIMITED IN DURATION TO THREE MONTHS FROM 
THE DATE OF DELIVERY TO PURCHASER.

LIMITS OF BKT's LIABILITY

BKT SHALL NOT BE LIABLE TO THE PURCHASER FOR LOSS OF DATA, LOSS OF PROFITS, 
LOST SAVINGS, INCIDENTAL, CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR 
DAMAGES ARISING FROM BREACH OF WARRANTY, BREACH OF CONTRACT , 
NEGLIGENCE OR OTHER LEGAL ACTION EVEN IF BKT OR ITS AGENT HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BROUGHT 
ABOUT BY YOU OR BY ANOTHER PARTY.
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1.0 INTRODUCTION

The PCI2002 is a second generation instrument designed for industry use as a tool for the measurement 
and prediction of inhibitor performance in metalworking, hydraulic water based fluids and lubricants.

The equipment consists of :-

a) A Mini-Cell test cell

b) A digitally controlled DUAL RANGE precision electrochemical potentiostat instrument unit.

c) A desktop P.C , fitted with an A/D , I/O card running C++ WINDOWS compiled executable 
analysis software (PciWin).
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2.0 OVERVIEW

Using PciWin the PCI 2002 instrument can be quickly and easily configured to perform one of three 
modes of electrochemical testing.

REST POTENTIAL

Used to display the metal/solution interface potential , gives visual evidence of the presence of 
inhibitors at a metal surface. Can be used to screen inhibitors for selective metals, or show 
active/passive transitions due to pH changes or aggressive ions.

CURRENT - TIME

Used to set an overpotential that locks inhibitors on a metal  surface, gives visual record of inhibitor 's 
long term stability.  Mainly used for inhibitor persistence tests.

SWEEP

Used to perform one of several potentiodynamic (SWEEP) tests.  See "Sweep Style" in PciWin 
Application Help.

Ramp One Way

Cycle

Centre Cycle

Central One Way
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SWEEP

Defaults to a Ramp One Way sweep test, gives visual display of the inhibitor filming characteristics of 
an oil emulsion or synthetic fluid system. Can be used to :-

a) Compare performance of proprietary fluids.

b) Compare dilution sensitivity of proprietary products.

c) Determine concentration of inhibitors required for trouble free performance in varying 
degrees of water hardness.

d) Illustrate synergysm of inhibitor systems.

e) Test recycled fluids for correct dosing of depleted additives.

f) Illustrate competitive ion effects ie effect of thickeners, EP additives, anti-foams on corrosion 
inhibitor performance.
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3.0 INSTALLATION

3.1 Installing the Hardware

a) MAKE SURE THAT THE COMPUTER  IS SWITCHED OFF AT THE MAINS,
BUT HAS IT'S MAINS LEAD CONNECTED AT THE REAR.
(ie THE CASE IS EARTHED)

b) (PC30AT Installation)
MAKE SURE THAT YOU TOUCH THE METAL CASING INSIDE THE COMPUTER 
BEFORE REMOVING THE AMPLICON CARD FROM IT'S STATIC PROTECTION 
PACKAGING. (THIS EARTHS THE STATIC ON YOU).

c) SLIDE THE CARD INTO AN EMPTY EXPANSION SLOT.

d) THE CARD IS SUPPLIED ALREADY CALIBRATED & SET UP FOR THIS 
APPLICATION.

e) ** THE ON BOARD WAIT STATE GENERATOR ON THE PC30AT CARD CAN BE 
VARIED TO SUIT THE I/O BUSS SPEED OF YOUR COMPUTER. **

WE HAVE SET THE CARD (JUMPER J17 TO POSITION 3, CORRESPONDING TO 
8-10 MHz ASSUMING YOUR COMPUTER IS A DELL WITH A STANDARD BUSS 
SPEED SEE P7 PC30AT MANUAL. IF YOU ARE OPERATING A DX2 MACHINE 
(CLOCK SPEED 66MHz , I/O BUSS SPEED 33 MHz) SELECT POSITION 1 

f) THIS JUMPER J17 IS THE ONLY SETTING ON THE CARD THAT MAY NEED TO BE 
CHANGED TO OPTIMISE SOFTWARE SPEED.

** PLEASE DO NOT TOUCH ANY OTHER CARD SETTING **

g) LOCATE THE PCI2002 VER2, 37/50 WAY LEAD TO CONNECT THE INSTRUMENT 
TO THE COMPUTER.

h) LOCATE EURO MAINS LEAD INTO CONNECTOR IN THE REAR OF THE 
INSTRUMENT.

i) TURN ON THE INSTRUMENT  VIA THE SWITCH ON THE EURO-MAINS SOCKET 
AT THE REAR   OF THE 
(POWER LED (RED) SHOULD LIGHT)

j) SWITCH ON COMPUTER AND MONITOR 
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3.2 Installing the Software

To install PciWin for the first time you must first copy the executable files onto the your hardrive , 
together with three .vbx control files. The "Install.bat" program supplied on the disc is designed to 
install PciWin from the Windows DOS prompt. The .bat program will create a directory C:\PCIWIN 
on your hardrive and will automatically copy files into this directory and the windows system 
directory.

To install this software follow the steps:-

a) From within windows double click on MS DOS Prompt icon in MAIN, at the C:\WINDOWS 
prompt 

type  A:\ install and press return.

b) After the batch file has copied the necessary files the message "Installation Complete Type EXIT 
and 

press return to close DOS window" should appear.

c) Type EXIT and return to Windows Program Manager

d) Select "Windows Setup" icon in MAIN and double click

e) From "Options" menu select Set up Applications

f) In Set Up Applications select "Ask to specify an application" Click OK

g) At the flashing cursor type " C:\PCIWIN\PCIWIN.EXE " click OK and close windows set up box

h) You should now have an Icon named PciWin in the Applications group box in Windows

i)  Double click this Icon to start PciWin

** PLEASE NOTE **

PciWin version 1.5 and above utilises dongel  copy protection. 

ENSURE THAT THE COMPUTER IS SWITCHED OFF.
Connect the dongel supplied into the parallel printer port 
of the DELL computer system unit.
Connect the printer cable into the back of the dongel.

Note :- computer parallel ports can be damaged by connecting and disconnecting dongels 
whilst the computer is switched on.
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3.3.1 Electrode (Metal) Specimen Preparation

PCI specimens are supplied with one face machine ground to approximately
a P400 surface finish. For consistency and reproducibility of test results it is essential that specimen 
preparation is adhered too. Prepare a specimen by polishing the ground surface wet on progressively 
finer P800 then P1200 Wet & Dry paper. Inspect surface for pits, and finish the surface by 10-20 
forward and backward polishing movements on a 50mm square virgin piece of P1200 Wet & Dry.

After finishing polishing, rinse the polished face under distilled water, and 
dry the specimen leaving the polished face wetted . 

Check the polished face for evidence of micro-pits if it is being reused after a Sweep test.

By leaving the specimen face wet a convex water meniscus which magnifies the surface will 
show any micro-pits if present. If the specimen surface is pit free assemble the Mini-Cell.

3.4 Instrument Status

No output to Mini-Cell test cell

Instrument is switched into HIGH range 
automatically to measure currents < 50uA

Instrument is running a test

Error detection over voltage and/or current
(Usually triggered when insufficient fluid in cell ie 
no current path between counter and specimen)
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4.0 USING THE INSTRUMENT (A QUICK GUIDE TO RUNNING A TEST)

4.1 Turning On and Off

When switching on the PCI System it is recommended good practice to switch ON the equipment 
in the sequence PCI2002 instrument unit first, followed by the Dell System Unit and Monitor.

Turn the instrument OFF by reverse sequence ie. instrument unit last.

4.2 Running Pci Win

Double click on the PciWin icon in the Applications group box in Windows to open PciWin.

PciWin Opening Screen
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Before you can begin running any test in PciWin you first have to open a  "Test Window".

Open a "Test Window" by clicking the mouse cursor on the button.

Resize or maximise your Test Window before , clicking one of  three possible test buttons that have 

now become active . Click on test button to select a Sweep Test.  The "Sweep Test 
Setup" box will appear, with the cursor automatically flashing in the "Test Name" box. Enter the test 
name "DUMMY CELL" , and then place the DUMMY CELL supplied with the instrument into the 
connector marked CELL on the front panel of the PCI2002.

The "Sweep Test Setup " box allows the user to configure all the sweep test variable test parameters. 
The test parameters are factory set to default to a standard Ramp One Way sweep. Application of 
sweep tests and sweep test variables are discussed in detail in section 5.0 named TEST 
APPLICATIONS.
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The default factory test parameters can be edited by using the TAB key on the keyboard to jump 
between input boxes and or by directly placing the cursor over the numbers and clicking the left mouse 
button to enter the box. These new test parameters can then be saved as "NEW DEFAULTS" by 
clicking on SAVE .

PRESS Return or click on OK to start a DUMMY CELL sweep test. The instrument will switch into 
ISOLATE status and the screen will display the "Approximate Rest Potential " box.

The actual value is not critical to a DUMMY CELL test and may vary from instrument to instrument if 
both DIGI-GALV and PCI 2002 share the same PC30AT card. (ie the card is set to zero the DIGI-
GALV opposed to the PCI instrument.)



13

PRESS Return or click on OK to initiate the test , the instrument will switch into RUN status and the 
screen will display the sweep test graph axes together with a new box, the "Run Time Sweep Statistics" 
(RTSS) box. The RTSS box displays the sweep parameters selected for the test and has two active 
buttons "HOLD/RESTART" and "STOP". Hold/Restart allows the user to suspend the sweep 
increment at a specific plot number or overpotential and maintain an Applied Voltage across the cell . 
The Stop button allows the user to abort a test.

When the  sweep range has been completed the Sweep Test automatically displays the box below :-
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Click on CANCEL for the moment (as this is only a DUMMY CELL test ) Normalisation of sweep 
tests is covered later in section 5.0. The box will disappear and the completed DUMMY CELL test will 
remain in its Test Window.

CONGRATULATIONS

You have just carried out your first test and also checked out your PCI system. Remember that the test 
is only held in the computer memory, so be sure to save it to disk by either FILE- SAVE , from the 

Menu or by clicking on the quick button CTRL +S.
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5.0 TEST APPLICATIONS

5.1 Rest Potential

Rest Potential tests are used to :-

a) Screen surface activity of water soluble additives on different metal specimens.

b) Show the presence of active/passive surface oxide layers on metals that exhibit dual 
metal/solution interface potentials.

c) Show that the system has reached an equilibrium inhibited solution/interface potential prior to 
initiating a sweep test.

As with all tests performed by PciWin, Rest Potential tests appear in a test window. The sequence to 
start a Rest Potential test is as follows :-

a) Open active test window by clicking on "New Test" on menu bar or Test and New using the 
Menu options.

b) Select Rest Potential from Test menu or CTRL + R, or click on 

c) The default set up box appears as below

The  default Rest Potential Test Setup box appears with the cursor automatically flashing in the "Test 
Name " box. Enter a test name, connect the mini-cell into the instrument and click on OK to proceed. 
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The factory defaults of 1 sec Reading Interval and 200 mV scaling are held in a separate file , so that 
clicking on Restore Factory at any time will restore these values. Test duration's can be increased by 
raising the Reading Interval for inhibitor persistence and stability testing. The Smoothing Factor is 
preset at 100 as a standard throughout the three modes of testing. Axes scaling is designed to scale the 
screen +- 200 mV about the first Rest Potential reading to allow for potential drifts with time or to 
display +- potential shifts due to additions of surface active agents. Axes scaling can be preset by 
selecting one of the four possible options using the radio buttons in the Rest Potential Test Setup box .

A typical example of a system responding to an addition of an inhibited solution is shown below:-

This is in fact only half of the curve , a full S curve can be generated by starting the test in water and 
adding a Semi-Syn or Synthetic fluid to the solution whilst the test is running. Steel in aerated water 
will exhibit an metal/solution potential of approx -550 mV or -0.55V , when water soluble inhibitors 
are present adsorption can be seen to raise this potential to typically -330 mV or -0.33V. It is this effect 
that is graphically visible that allows the instrument to be used to screen possible surface active agents.
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5.2 Current-Time

I/T tests are used to :-

a) Show the ability of adsorbed inhibitors to resist oxidation or reaction with competing aqueous 
anions.

b) Show selective adsorption at different overpotentials.

As with all tests performed by PciWin, I/T tests appear in a test window . The sequence to start an I/T 
test is as follows :-

a) Open active window by clicking on "New Test" on the menu bar or Test and New using the 
Menu options.

b) Select Current from the Test menu or CTRL + C, or click on

c) The default  Current Test Setup box appears as below

The default Current Test Setup box appears with the cursor automatically flashing in the "Test Name" 
box . Enter a test name, connect the mini-cell into the instrument and click on OK to proceed.
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5.3 Sweep

Sweep tests are used to :-

a) Compare performance of proprietary fluids.

b) Compare dilution sensitivity of proprietary products.

c) Determine concentration of inhibitors required for trouble free performance in varying 
degrees of water hardness.

d) Illustrate synergism of inhibitor systems.

e) Test recycled fluids for correct dosing of depleted additives.

f) Illustrate competitive ion effects ie effect of thickeners, EP additives, anti-foams on corrosion 
inhibitor performance.

As with all tests performed by PciWin, Sweep tests appear in a test window . The sequence to start a 
Sweep test is as follows :-

a) Open active window by clicking on "New Test" on the menu bar or Test and New using the 
Menu options.

b) Select Sweep from the Test menu or CTRL + P, or click on

c) The default  Sweep Test Setup box appears as below
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The Sweep Test Setup box can be broken down into three sections :-

a) Sweep Style

b) Test Variables

c) Begin Sweep

Sweep Style

The default sweep style is set for a Ramp One Way standard sweep test . However the sweep style can 
be preset by selecting any of the four possible sweep options using the radio buttons.

Ramp One Way

Cycle

Centre Cycle

Central One Way



20

Tests on water based fluids and synthetic solutions are normally carried out using the Ramp One Way 
sweep style, under the Test Variables developed and optimised by BKT for testing of lubricants. The 
PciWin program automatically loads the Test Variables box with these parameters as default 
parameters.

Ramp One Way

The default sweep setting , will sweep the Applied Voltage either positive/negative from the limits as 
defined in the Sweep Range. The Sweep Range is selected in the Test Variables box, and is the voltage 
range over which a test is performed. **Note** the Sweep Range is applied +- about the system's 
measured Rest Potential.

Cycle

This will execute a Ramp One Way test until the upper limit is reached, then the cycle reverses the 
ramp direction and produces a second ramp until the lower limit is reached.

Centre Cycle

This operation initiates the Applied Voltage from the measured Rest Potential reading, ( as opposed to 
an upper or lower sweep limit ). The ramp will proceed either +- from the measured Rest Potential, 
until a limit is reached then the ramp direction is reversed, the sweep will pass through the system's 
Rest Potential and continue until the next limit is reached, then reverse to return to the Rest Potential.

Central One Way

This option reads the system's Rest Potential, then applies +- 200 mV before outputting an Applied 
Voltage then executes a Ramp One Way test until the upper or lower limit is reached. 

e.g.: If the system's Rest Potential is read as -0.5V then assuming a positive ramp direction the 
test's first Applied Voltage will be applied at -0.7V and a Sweep Range of 1000mV would produce 

an Applied Range of -0.7V to + 0.3V.

Test Variables

Sweep Range

The voltage range over which the sweep test is to be performed. The sweep range is applied 
symmetrically about the systems Rest Potential. Valid parameters +- 200mV- 2V.

Increment Size

The magnitude of the change of Applied Potential in mV that is output per increment/decrement of the 
sweep .

Smoothing Factor

This  is the number of readings that will be read from the ADC  for each plot point. The readings are 
averaged to produce a value which smoothes out any double layer transients before screen plotting.
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Reading Intervals

The time that will elapse between consecutive plot point readings.

Solution I R Drop Factor

A scaling factor that dynamically adjusts the Y axes scaling to take into account the reference electrode 
not reading the true applied voltage when testing highly resistive solutions ie HFB fluids and some 
water glycol fluids.  Defaulted to 1.0 for water based fluids.

Corrosion Constant

A scaling factor that dynamically adjusts the X axes to take into account different cell designs and IR 
drops across the counter and working electrode . ( ie the solution resistance )
Defaulted to 1.0 for water based fluids.

Begin Sweep

Defaulted to negative

The sweep test will commence by imposing a Cathodic overpotential specifically, the Sweep Range 
above/below the Rest Potential  will be subtracted from the Rest Potential and the resultant voltage is 
what will be applied between the working electrode  ( metal specimen ) and the calomel reference 
electrode.

Normalisation of Sweep Tests

In order to use the advanced features of PciWin's Overlay and Statistics facilities we have introduced 
the term Normalisation.

Normalisation of a sweep test allows the user to select a position on the curve ( usually the Rest 
Potential ) which is then shifted to the x axes. If the Rest Potential is selected ( the minimum current 
value ) the test is further displayed symmetrically about the x axes. Upto four Normalised sweep tests 
can be overlaid in a single Test Window using the Open Multiple option from the File menu.

At the end of a Sweep Test PciWin automatically displays the box below :-
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Click on OK to proceed with Normalisation. The box will disappear and the cursor will change from 
an arrow to a cross hair (+). Maximise the Test Window and position the cross hair on the minimum 
current value , once in position double click the left hand mouse button to select. An example screen is 
shown below :-

The adjust data offset is displayed in the information box. This value -407 mV or -0.407 V (the 
system's Rest Potential in this case ) will be subtracted from all  data points.

Select YES to proceed.

The Test Window will reappear with the sweep test , the value -407 mV has been saved temporarily in 
the data file associated with the test. Be sure to resave the test in its new form under   File _Save or 
Save_As if renaming. The test file data can be displayed in PciWin by selecting the option   Ctrl + V 
whilst the Test Window is active.

A  Normalised sweep test is shown on the following page.
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Statistics

PciWin will report electrochemical data , corrosion rate statistics and Tafel Slope Ba , Bc values in 
accordance with Tafel polarisation theory and the electrochemical mixed potential Tafel 
extrapolation method. A detailed explanation of corrosion theory underlying this analysis is beyond 
the scope of this manual however a simple and clear reference text covering these methods is :-

Gelling P. J
Introduction to corrosion prevention & control for engineers
Delft University Press 1976
Electro Chem Monographs for Teachers Series

Note :-

a) Tafel extrapolation methods only strictly apply to tests on inhibited and uninhibited 
steels in acid solutions. As the Tafel equations are written for active polarisation control.

b) Statistics can only be undertaken on Normalised Sweep tests.
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However an indication for comparative purposes of the corrosion inhibition afforded by an oil 
emulsion system can be obtained by selecting a linear area of anodic film formation on an inhibited 
sweep test. Select Statistics by clicking on Options from the file Menu and then Do Statistics, or by 

selecting from the tool bar.

An example of the statistics screen is shown below :-

We have assumed here that the point of ANODIC FILM FORMATION , represents the maximum 
corrosion dissolution current that will flow when the fluid is put into practice. PciWin allows the user 
to select this point when in Statistics mode . By selecting the most +ve high point for analysis above 
this point followed by the point of ANODIC FILM FORMATION as the +ve low point the Statistics 
routine will carry out a "Least Squares" curve fit between the two selected points and will extrapolate a 
straight line back to the X axes. The value of current at this point (i-Corr ,a) mA  is then used in the 
Statistics formula to return a corrosion rate , Rate-a (um/yr).
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Overlaying

PciWin has the facility to overlay upto four sweep tests (*.pci files) inside a single Test Window. This 
is typically used to display the effects of dilution on fluid performance and or water aggressiveness at 
constant dilution.

To overlay sweep tests relative to their individual Rest Potential's it is usual practice to Normalise the 
tests prior to overlaying.

Select overlay sweep tests by clicking on  Open Multiple (Ctrl +M ) from the File Menu , or by 

selecting from the tool bar. From the OPEN popup box select upto four sweep tests by 
using the standard Windows multiple selection procedure (CTRL + Click ) the left hand mouse button. 
After selecting a maximum of four tests to overlay click on OK or press keyboard Return. An example 
of a Test Window with two overlaid Normalised tests is shown below:-
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6.0 PciWin SOFTWARE IN DETAIL

6.1 The Main Screen

The main window appears immediately after PciWin is opened . Here we have additionally displayed 
the File Open box from the File Open (Ctrl + O) , Menu bar. The labelled parts of the main window 
are referred to in the following pages.

The Control-menu button is in the upper-left corner of the window. Clicking on the control menu box 
displays the control menu which contains commands to resize, move, close windows, and switch to 
another task running under Windows. Double clicking on the control menu box exits PciWin.
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The Title bar contains the title for the window. The title will be PciWin on the main window. 
Other windows will display File name or Plot number.

The Minimise/Maximise buttons reduces the active window to an icon or enlarges the active 
window to fill the entire desktop.

The Menu bar contains the PciWin commands. The menu bar groups commands together in 
menus. Each menu's name appears on the Menu bar. The available menus are File, Test, 

View, Window, Options, and Help.

The Tool bar is a collection of quick reference buttons which give instant access to many of 
the menu bar  functions .

A Test Window is automatically opened either for displaying a New Test or opening a test file.

The File Open Box displays files held on disc and allows selection of files for screen display 
inside a Test Window.

6.2 Displaying Tests

Tests are displayed by opening test files using the File Open Box . PciWin recognises three File Types, 
namely *.pci, *.rst, *.ctp which relate to Sweep, Rest Potential and Current -Time tests. The File Open 
Box can be opened in TWO modes, Open and Open Multiple.

File Open (Ctrl + O) allows the selection of a Single test file , and opens a 
single *.pci, *.rst, or *.ctp test file which is displayed in a Test Window.

File Open Multiple (Ctrl + M) allows the selection of upto four Sweep Test 
*.pci files which can be overlayed inside a single Test Window.  Multi-Select inside the File 
Open Box using the Ctrl + Click Windows mouse function. 
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The Import DOS function in the File menu allows the conversion of old Sweep and Rest Potential 
files generated on PCI 2000 Ver I instruments into PciWin format. This facility is Pci-Soft version 
dependant and requires the data to be held in ASCI II text format a facility provided by later versions 
of Pci-Soft Nov 92 onwards.

File Close (Ctrl + F4) will close the active Test Window . The focus will shift 
to the next Test Window in the reverse of the opening sequence.

6.3 Manipulating Tests On-Screen

By repeating File Open (Ctrl + O) commands you can open multiple existing tests. The only limit to 
the number of tests open at one time is the computer system's memory, however a practical limit of 20 
is suggested for file manipulation as displaying multiple graphic images has a toll on computer 
efficiency.

Using the Window Tile option from the  Menu Bar the tests can be displayed as shown below :-

The active Test Box is always highlighted and it's filename appears on the Title Bar at the top of the 
main window screen. Highlight a new active Test Box by clicking inside a Test Window.
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Manipulation of Test Window box's obey the same rules as per sizing, resizing and moving of any 
Window as detailed in your Windows 3.1 "User's Guide".

To move a Test Window , click the mouse inside the Title bar and drag the window to it's new 
location. The Window option from the Menu Bar lists 1-9 Test Windows and displays more if there is 
greater than 10 Test Windows open. Click on more to browse 10+ tests.

6.4 Viewing Test Window data

The File View/Print Text (Ctrl +V) option in the menu bar displays the test data associated with the 
highlighted active Test Window. Selecting this option automatically opens Windows Notepad and the 
data file associated with the active Test Window. A printout of this testdata can be obtained using the 
File Print option in Notepad's menu bar.
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6.5 Printing the Active Window

The File Print Plot option in the menu bar prints the active Test Window using Windows Print 
Manager.  The Windows printer setup can be displayed from within PciWin using the File Print Setup 
...  option.

This screen shows an example printer setup for a Canon LBP-8 IV laser .

6.6 Saving Tests to Disc

File Save option from the menu bar saves the active Test Window to  disc , 
provided the test is a New Test. If the test has been saved previously then the quick button 

will not be active and the test can only be saved using the File Save As ... option.
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6.7 Changing the Test Name and Date

The Options Change Name/Date (Ctrl + D) option in the menu bar allows the user to retrospectively 
alter the Test label associated with the Test Window. The Test Name must not be confused with the 
Test File name which can only be changed using the File Save As ... option.

The Test Name can be altered by typing a new set of labels inside the CHANGE TEST NAME/DATE 
box.

6.8 Positioning X-axis Labels

The Position X-axis Labels... option will position the x axes labels if obscured by test data.

The three positions available are:-

Top of Window Ctrl + T
Above X-axis Ctrl + X
Below X-axis Ctrl + B
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7.0 THE AUTO TEST FEATURE

Test Automatic (Ctrl + A) option from the menu bar enables the auto test 
feature of PciWin. The auto test feature is designed to test the system for stabilisation 
automatically using a conditional Rest Potential test procedure followed by an automatic 
Sweep Test  when the stability conditions as set out in the Rest Potential test criteria have 
been met. The Automatic Test Setup box allows the user to define conditions of stability for 
consecutive  metal/solution potential readings. The test then applies these conditions in an 
either/or conditional way until such time as the stability conditions are met. When the system 
has stabilised the auto feature starts a Sweep Test as defined in the Sweep Test Setup box.

Using the quick test buttons click on followed by to initiate an automatic test. 
Select the sweep setup conditions as requested in the Sweep Test Setup Box and select a window 
of acceptance for voltage readings defaulted to 50 mV and the number of readings required to fall 
within this window defaulted to 10.
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Select the required test variables from the Rest Potential Test Setup box and click on OK.

PciWin will initiate a test based on these preselected test variables and test conditions. The Rest 
Potential test will read metal/solution voltages until ten readings are read to be consecutively within 50 
mV difference, upon such time the auto feature will start a Sweep Test.


